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Abstract- The paper presents an approach to design rapid and 

fluid movements of a universal robot to perform robot writing 

mimicking the doctor prescription writing when signing and 

the trajectory. Reading a doctor’s handwritten prescription is 

a challenge that most patients and some pharmacists face; an 

issue that, in some cases, lead to negative consequences due to 

wrong deciphering of the prescription. Part of the reason why 

doctor's prescriptions are so difficult to decipher is that 

doctors make use of Latin abbreviations and medical 

terminology that most people don't understand. To perform the 

task, on-line human signing standards are created first. Robot 

writing task is performed using these standards after that and 

robot signatures are acquired as a result. Finally, 

recommendations of robot motion improvement are given. 

 A number of developing countries continue to provide 

educational services with disabilities in segregated schools. 

Also, all students, regardless of their personal circumstances 

have a right of access to and participation in the education 

system, according to their potential and ability. However, with 

the rapidly growing population and increasing number of 

people with blindness along with other disabilities, need for 

use of technology in the field of education has become 

imminent Thus the application will help in creating an 

environment that provides equal opportunities for all the 

students in taking up competitive exams. This will also 

improve the current educational systems for blind career.   

 

Keywords- Landmine detection robot, Metal detector, Multiple 

sensors, Raspberrypi-3, IoT. 

 

I. INTRODUCTION 

 

Blindness is one of the most, misunderstood type of 

disability. The general masses have their own pre-conceived 

notions about the blind people that they firmly believe to be 

true without even getting in touch with a blind person. Most of 

the members of the non-blind community believe that the 

blind people cannot do their work or live a normal life. Blind 

people do lead a normal life with their own style of doing 

things. But they definitely face troubles due to inaccessible 

infrastructure and social challenges. Let us have an empathetic 

look at some of the daily life problems faced by the blind 

people. Main problem is when the blind person cannot be able 

to write their ideas on paper, with help of other or parents the 

blind person can write their ideas etc. The biggest challenge 

for a blind person, especially the one with the complete loss of 

vision, is to navigate around places. Obviously, blind people 

roam easily around their house without any help because they 

know the position of everything in the house. People living 

with and visiting blind people must make sure not to move 

things around without informing or asking the blind person. 

Commercial places can be made easily accessible for the 

blinds with tactile tiles. But unfortunately, this is not done in 

most of the places. This creates a big problem for blind people 

who might want to visit the place. Blind people have a tough 

time finding good reading materials in accessible formats. 

Millions of people in India are blind but we do not have even 

the proper textbooks in braille, leave alone the novels and 

other leisure reading materials. Internet, the treasure trove of 

information and reading materials, too is mostly inaccessible 

for the blind people. Even though a blind person can use 

screen reading software but it does not make the surfing 

experience very smooth if the sites are not designed 

accordingly. Blind person depends on the image description 

for understanding whatever is represented through pictures.    

 

II. LITERATURE SURVEY 

 

[1] Voice based online examination for physically challenge: 

The growth of the Internet, and in particular the World Wide 

Web, is already influencing the way science is taught and will 

undoubtedly do so to greater extent in the future. In areas of 

education it offers a medium that has the potential to be more 

responsive to students. To encourage greater participation in 

their own learning, and to give greater access to different 

sources of information than traditional methods offers. In the 

future blind peoples also can do online exam like a normal 

human if our project is delivered in real time. 

 

[2] Nowadays more and more individuals are turning to robots 

to do their work because robots are more versatile, accurate, 

reliable and also reduce human efforts. Robotic arms are 

programmed robot with similar function of a human arm. Aim 

of our project is to develop font style writing using voice as 
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input. Aim of our project is to develop font style writing using 

voice as input. This can be helpful for various applications 

such as people with dysgraphia, which is writing disability can 

use this machine to create trajectory moments with the voice 

as input. Physically challenged people can also use this 

machine for scribina purpose.  

 

[4] Universal robot employment to mimic human writing: The 

paper presents an approach to design rapid and fluid 

movements of an universal robot to perform robot writing 

mimicking both the human kinematics when signing and the 

trajectory. To perform the task, on-line human signing 

standards are created first. Robot writing task is performed 

using these standards after that and robot signatures are 

acquired as a result. Next, both human and robot signatures 

are analyzed and compared, and the degree of signatures 

correlation is defined. Finally, recommendations of robot 

motion improvement are given. In this paper, we present a 

method to design rapid and fluid movements of a universal 

robot to perform robot writing mimicking the kinematics and 

trajectory of human handwritten signatures. The handwriting 

specimen acquisition, writing specimen processing, robot 

writing and comparison of on-line human and robot signatures 

are the phases of the experimental research performed. The 

phases are the steps of the presented method implementation.  

 

[5] Voice based writing machine using speech recognition: 

The people who are not able to write are losing the 

opportunities in this competitive society. This proposed 

system is developed for the physically disabled and differently 

abled people who do nothave the ability to write, due to 

absence of arm, which may limit the quality of creative 

expressions. This proposed system is helpful for physically 

challenged person who does not have ability to write due to 

absence of arm. The lack of writing arm may limit the quality 

of creative expressions. But same person can speak and that 

vocal words sensed by the microphone, processed by the 

Arduino Uno which actuate the robotic arm assembly. The 

Mechanical arrangement with the pen made such that it moves 

on Axial co-ordinates and capable of writing words on the 

paper. The fastest processing speed of Arduino Uno has 

utilized to achieve high speed of writing operation.  

 

[6] Boosting neuro evolutionary techniques for speech 

recognition: In this work we experimented on the most 

challenging part of the speech recognition task, identifying the 

optimal network architecture with a promising set of hyper 

parameters and explored the automated improvement 

techniques around the set. To this end it has been identified 

that the candidate network parameters can be efficiently tuned. 

 

[7] Design and detection of writing robot using speech 

processing: This paper aims to help the students who are 

having difficulties in writing the examination and effectively 

replaces the existing system of using a third- party scribe 

using speech to text and text to writing using robot. 

 

III. EXISTING METHOD 

 

We present a method to design rapid and fluid 

movements of a universal robot to perform robot writing 

mimicking the kinematics and trajectory of human 

handwritten signatures. The handwriting specimen acquisition, 

writing specimen processing, robot writing and comparison of 

on-line human and robot signatures are the phases of the 

experimental research performed. The phases are the steps of 

the presented method implementation. In the given paper, 

more attention was paid to the technology of written 

specimens’ processing, experimental robotic set-up 

description as well as the control process of UR5 while 

performing writing task. Obtained human and robot writing 

specimens were processed. Acquired human and robot writing 

trajectory and speed profiles were compared and evaluated. 

Quality of the obtained robot trajectory profile is high. The 

increasing of the quality of robot speed profile by the 

reduction of inertia of robot arm parts in parallel with optimal 

task placement in robot workspace was defined as the future 

direction of the presented research. 

 

DRAWBACK 

 

 It only exploits the writing specimen processing. 

 A process of UR5 is difficult to understand. 

 No real time implementation. 

 

IV. PROPOSED SYSTEM 

 

The writing robot makes the person’s exam paper 

with the help of wireless communication. The movement Code 

file created by the help of Inkscape software then the 

processing software is used to send the G-Code file to the 

microcontroller. Then the CNC shield drive sends the 

controlling signals to the stepper motors and servo motor. 

Now the XY axis which operates as follows by the 

instructions given to the controller unit. The corresponding 

code is send the data to controller block is interfaced with 

motor driver unit along the DAC provides the pulse width 

signal to motor unit where it is being processed and final 

output is written and displayed on the paper from the output 

unit. 

 

ADVANTAGES 
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 Help blind people to write the exam on their own. 

 Increases confidence of blind people. 

 Accuracy 

 Optimized character axis. 

 Less delay 

 Low cost 

 

V. METHODOLOGY 

 

This project is used for reducing traffic to 50 

percentages in tollgates. So, here we will be analysis the 

number plate as well as vehicles which and whichever vehicle 

is taking return ticket For them the gate will be automatically 

opened for the particular vehicle when it comes back. Initially 

the first step in this model generation will be collection of 

dataset. We will be collecting different types of dataset from 

the internet and various resources of different vehicles and its 

number plate such that it can be trained by which our system 

can analysis the different vehicles and its number plate then 

the data set will separated into two parts, training as well as 

testing. Training dataset will be used for training the model 

completely whereas the testing dataset will be kept separately 

which will be used for testing in the last when the model is 

completely generated. 

 

 
Fig 1. System architecture 

 

V. HARDWARD REQUIREMENT 

 

A. BLUETOOTH MODULE 

 

It is used for many applications like wireless headset, 

game controllers, wireless mouse, wireless keyboard and 

many more consumer applications. It has range up to <100m 

which depends upon transmitter and receiver, atmosphere, 

geographic & urban conditions. It is IEEE 802.15.1 

standardized protocol, through which one can build wireless 

Personal Area Network (PAN). It uses frequency-hopping 

spread spectrum (FHSS) radio technology to send data over 

air. It uses serial communication to communicate with 

devices. It communicates with microcontroller using serial 

port (USART). 

 
Fig 2. HC-05 Bluetooth 

 

A.POWER SUPPLY MODULE 

 

The power supply circuit consists of step-down 

transformer which is 230v step down to 12v.In this circuit 

4diodes are used to form bridge rectifier which delivers 

pulsating dc voltage & then fed to capacitor filter the output 

voltage from rectifier is fed to filter to eliminate any ac 

components present even after rectification. The filtered DC 

voltage is given to regulator to produce 12v constant DC 

voltage. 230V AC power is converted into 12V AC (12V 

RMS value wherein the peak value is around 17V), but the 

required power is 5V DC; for this purpose, 17V AC power 

must be primarily converted into DC power then it can be 

stepped down to the 5V DC. AC power can be converted into 

DC using one of the power electronic converters called as 

Rectifier. There are different types of rectifiers, such as half- 

wave rectifier, full-wave rectifier and bridge rectifier.  

 

 
Fig 3. Power supply 

 

B. PIN DESCRIPTION 

 

 
Fig 4. Pin description 
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C.SERVO MOTOR 

 

A servo motor is an electrical device which can push 

or rotate an object with great precision. If you want to rotate 

and object at some specific angles or distance, then you use 

servo motor. It is just made up of simple motor which run 

through servo mechanism. If motor is used is DC powered 

then it is called DC servo motor, and if it is AC powered 

motor then it is called AC servo motor. We can get a very high 

torque servo motor in a small and light weight packages. Doe 

to these features they are being used in many applications like 

toy car, RC helicopters and planes, Robotics, Machine etc. 

 

 
Fig 5. Servo motor 

 

D.STEPPER MOTOR 

 

A stepper motor is an electromechanical device it 

converts electrical power into mechanical power. Also it is a 

brushless, synchronous electric motor that can divide a full 

rotation into an expansive number of steps. The motor’s 

position can be controlled accurately without any feedback 

mechanism, as long as the motor is carefully sized to the 

application. Stepper motors are similar to switched reluctance 

motors.The stepper motor uses the theory of operation for 

magnets to make the motor shaft turn a precise distance when 

a pulse of electricity is provided. The stator has eight poles, 

and the rotor has six poles. The rotor will require 24 pulses of 

electricity to move the 24 steps to make one complete 

revolution. Another way to say this is that the rotor will move 

precisely 15° for each pulse of electricity that the motor 

receives. 

 

 
Fig 6. Stepper motor 

 

E. AVR MICROCONTROLLER:  

 

AVR Microcontroller is used as processing module 

and it is used as send data to LCD Screen and Gate way 

module. AVR is a family of microcontrollers developed by 

Atmel beginning in 1996. These are modified Harvard 

architecture 8- bit RISC single-chip microcontrollers. AVR 

was one of the first microcontroller families to use on-chip 

flash memory for program storage, as opposed to one-time 

programmable ROM, EPROM, or EEPROM used by other 

microcontrollers at the time. The AVR architecture was 

conceived by two students at the Norwegian Institute of 

Technology (NTH), Alf-Egil Bogen and Vegard Wollan. 

 

 
Fig 7. Pin diagram 

 

VI. SOFTWARE REQUIREMENT 

 

A. ARDUINO SOFTWARE:  

 

The Arduino Integrated Development Environment 

or Arduino Software (IDE) - contains a text editor for writing 

code, a message area, a text console, a toolbar with buttons for 

common functions and a series of menus. It connects to the 

Arduino and Genuino hardware to upload programs and 

communicate with them. Programs written using Arduino 

Software (IDE) are called sketches. These sketches are written 

in the text editor and are saved with the file extension .ino. 

The editor has features for cutting/pasting and for 

searching/replacing text. The message area gives feedback 

while saving and exporting and also displays errors. The 

console displays text output by the Arduino Software (IDE), 

including complete 49 error messages and other information. 

The bottom righthand corner of the window displays the 

configured board and serial port. 

 

B.TABS, MULTIPLE, FLIES AND COMPILATION: 

  

Allows you to manage sketches with more than one 

file (each of which appears in its own tab). These can be 
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normal Arduino code files (no visible extension), C files (.c 

extension), C++ files (.cpp), or header files (.h). Before 

uploading your sketch, you need to select the correct items 

from the Tools > Board and Tools > Port menus On Windows, 

it's probably COM1 or COM2 (for a serial board) or COM4, 

COM5, COM7, or higher (for a USB board) - to find out, you 

look for USB serial device in the ports section of the Windows 

Device Manager. On Linux, it should be /dev/ttyACMx , 

/dev/ttyUSBx or similar. Once you've selected the correct 

serial port and board, press the upload button in the toolbar or 

select the Upload item from the Sketch menu. Current 

Arduino boards will reset automatically and begin the upload. 

With older boards (preDiecimila) that lack auto-reset. 

 

C. LIBRARIES 

 

Libraries provide extra functionality for use in 

sketches, e.g. working with hardware or manipulating data. To 

use a library in a sketch, select it from the Sketch > Import 

Library menu. This will insert one or more #include 

statements at the top of the sketch and compile the library with 

your sketch. Because libraries are uploaded to the board with 

your sketch, they increase the amount of space it takes up. If a 

sketch no longer needs a library, simply delete its #include 

statements from the top of your code. There is a list of 

libraries in the reference. Some libraries are included with the 

Arduino software. Others can be downloaded from a variety of 

sources or through the Library Manager. Starting with version 

1.0.5 of the IDE, you do can import a library from a zip file 

and use it in an open sketch. See these instructions for 

installing a third-party library. 

 

D.THIRD PARTY HARDWARE 

 

Support for third-party hardware can be added to the 

hardware directory of your sketchbook directory. Platforms 

installed there may include board definitions (which appear in 

the board menu), core libraries, bootloaders, and programmer 

definitions. To install, create the hardware directory, then 

unzip the third-party platform into its own sub-directory. 

(Don't use "arduino" as the sub-directory name or you'll 

override the built-in Arduino platform.) To uninstall, simply 

delete its directory. 

 

E. SERIAL MONITOR 

 

This displays serial sent from the Arduino or 

Genuino board over USB or serial connector. To send data to 

the board, enter text and click on the "send" button or press 

enter. Choose the baud rate from the drop-down menu that 

matches the rate passed to Serial.begin in your sketch. Note 

that on Windows, Mac or Linux the board will reset (it will 

rerun your sketch) when you connect with the serial monitor. 

Please note that the Serial Monitor does not process control 

characters; if your sketch needs a complete management of the 

serial communication with control characters, you can use an 

external terminal program and connect it to the COM port 

assigned to your Arduino board. 

 

F. BOARDS 

 

The board selection has two effects: it sets the 

parameters (e.g. CPU speed and baud rate) used when 

compiling and uploading sketches; and sets and the file and 

fuse settings used by the burn bootloader command. Some of 

the board definitions differ only in the latter, so even if you've 

been uploading successfully with a particular selection you'll 

want to check it before burning the bootloader. You can find a 

comparison table between the various boards here. Arduino 

Software (IDE) includes the built in support for the boards in 

the following list, all based on the AVR Core. The Boards 

Manager included in the standard installation allows to add 

support for the growing number of new boards based on 

different cores like Arduino due, Arduino zero, Edison and 

Galileo and so on. 

 

ADVANTAGES 

 

 Easily Customizable  

 Low power consumption  

 Low cost  

 Enhanced performance 

 

DISADVANTAGES 

 

 High development effort  

 Larger time to market 

 

VII. RESULT 

 

The prime idea of our project is to convert human 

speech into textual matter without any difficulty and hassles. 

The major advantage is that it can write down the spoken 

contents on a paper . The word or speech we speak is first 

converted into G-code by using google translation mechanism 

. This specific G-code is then transferred to the writing 

machine is by using a Wi-Fi module attached to it. After 

receiving the G-code the plotter recognize and identifies the 

co-ordinates of each character and write the alphabet.This will 

helps the blind and handicapped to write based on their voice 

commands without errors. 
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Fig 8. Output 

 

VIII. CONCLUSION 

 

In conclusion, developing a writing robot using 

speech processing technology can greatly benefit individuals 

who may face challenges with traditional writing methods. 

This technology can provide a more accessible and convenient 

way for people with disabilities or those who prefer to use 

speech as their primary mode of communication to write and 

express themselves. With advancements in speech recognition 

and natural language processing, writing robots can accurately 

transcribe speech into text and perform tasks such as 

proofreading and formatting. This technology has the potential 

to enhance the independence and productivity of individuals 

and can be applied in various fields such as education, 

healthcare, and business. This project helps handicapped 

people, medical doctors, and blind people. Blind people and 

handicapped people to write the exams on their own. By 

following this process, we can avoid a lack of scribes due to 

heavy paperwork and also maintain their independence.  

 

IX. FUTURE WORK 

 

In the coming future, we review the application of 

writing robot for blind people in the education field and it can 

promote for many purposes of robot with more features for 

blind people compared to this project. In this field there have 

more chance to develop or convert this project in many ways. 

This provides next step of education for blind people. 

 

 Improving accuracy: While speech recognition 

technology has come a long way, there is still room 

for improvement in terms of accuracy. Future work 

could focus on developing more sophisticated 

algorithms that can better understand different 

accents and speech patterns.  

 Expanding language support: Currently, most speech 

recognition software supports only a limited number 

of languages. Future work could focus on expanding 

language support to make this technology more 

accessible to people around the world.  
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